
HP EliteBook 2170p Notebook PC

Maintenance and Service Guide



© Copyright 2012 Hewlett-Packard
Development Company, L.P.

Bluetooth is a trademark owned by its
proprietor and used by Hewlett-Packard
Company under license. Intel and Core are
trademarks or registered trademarks of Intel
Corporation in the United States and other
countries. Microsoft and Windows are U.S.
registered trademarks of Microsoft
Corporation. SD Logo is a trademark of
its proprietor.

The information contained herein is subject
to change without notice. The only
warranties for HP products and services are
set forth in the express warranty statements
accompanying such products and services.
Nothing herein should be construed as
constituting an additional warranty. HP shall
not be liable for technical or editorial errors
or omissions contained herein.

First Edition: June 2012

Document Part Number: 677134-001



Safety warning notice

WARNING! To reduce the possibility of heat-related injuries or of overheating the device, do not
place the device directly on your lap or obstruct the device air vents. Use the device only on a hard, flat
surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft surface,
such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact the
skin or a soft surface, such as pillows or rugs or clothing, during operation. The device and the AC
adapter comply with the user-accessible surface temperature limits defined by the International
Standard for Safety of Information Technology Equipment (IEC 60950).
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1 Product description

Category Description

Product Name HP EliteBook 2170p Notebook PC

Processors ● Intel® Dual Core® i7-3667U 1.80-GHz processor (SC turbo up to 2.90-GHz; 4.0-
MB L3 cache, 17 W)

● Intel Dual Core i5-3427U 1.70-GHz processor (SC turbo up to 2.70-GHz; 3.0-
MB L3 cache, 17 W)

● Intel Dual Core i5-3317U 1.70-GHz processor (SC turbo up to 2.60-GHz; 3.0-
MB L3 cache, 17 W)

● Intel Dual Core i3-3217U 1.80-GHz processor (3.0-MB L3 cache, 17 W)

Chipset Mobile Intel QM77 chipset

Graphics Intel HD Graphics 4000 integrated universal memory architecture (UMA) graphics

Panel 11.6-in light-emitting diode (LED), high-definition (HD), AntiGlare (AG), SVA (1368×768)
display with and without webcam and microphone

All display assemblies include two wireless local area network (WLAN) antenna cables and
two wireless wide area network (WWAN) antenna cables

Supports low voltage differential signalling (LVDS)

Supports optional privacy filter

Memory Two customer-accessible/upgradable memory module slots

DDR3-12800 (1600-MHz) dual channel support

Supports 16384-MB of system RAM in the following configurations:

● 16384-MB (8192-MB×2, dual channel)

● 12288-MB (8192-MB×1+4096-MB×1, dual channel)

● 8192-MB (8192-MB×1 or 4096×2, dual channel)

● 4096-MB (4096-MB×1 or 2048-MB×2, dual channel)

● 2048-MB (2048×1)
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Category Description

Hard drive Supports 6.35-cm (2.5-in) hard drives in 9.5-mm (.37-in) and 7.0-mm (.28-in) thicknesses
(all hard drives use the same bracket)

Customer-accessible

Serial ATA

Supports the following hard drives:

● 750-GB, 7200-rpm, 9.5-mm

● 500-GB, 7200-rpm, 7.0-mm self-encrypting drive (SED)

● 500-GB, 7200-rpm, 7.0-mm

● 320-GB, 7200-rpm, 7.0-mm

Solid-state drive Solid-state drive (SSD) mounts in the same bracket as the hard drive

Customer-accessible

Serial ATA type II and III

Supports the following SSDs:

● 256-GB SED III

● 180-GB III

● 160-GB II

● 128-GB III

Audio and video Two stereo speakers

HD audio with SRS Premium Sound PRO

Integrated 720p HD webcam (supports no camera option)

Integrated dual-array microphone on computer models equipped with a webcam

Integrated mono microphone on computer models not equipped with a webcam

Ethernet Intel 82579LM 10/100/1000 Ethernet network interface card (NIC)

NIC Power Down technology

S3/S4/S5 wake on LAN

Ethernet cable not included
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Category Description

Wireless Integrated wireless local area network (WLAN) options by way of wireless module

Two WLAN antennas built into display assembly

Support for the following WLAN formats:

● Atheros AR9462 802.11a/b/g/n 2×2 Bluetooth 4.0 Combo Adapter

● Broadcom 4313GN 802.11b/g/n 1×1 WiFi and 20702 Bluetooth 4.0
Combo Adapter

● Intel Centrino Advanced-N 6235 WLAN module

● Intel Centrino Advanced-N 6205 WLAN module

Support for no WLAN option

 Integrated wireless wide area network (WWAN) options by way of wireless module

Two world-wide/5-band WWAN antennas built into display assembly

Secured by subscriber identity module (SIM, user-accessible inside battery bay)

Support for the following WWAN formats:

● HP lt2523 LTE/HSPA+ Mobile Broadband Module

● HP lt2522 LTE/EV-DO Mobile Broadband Module

● HP un2430 EV-DO/HSPA Mobile Broadband Module

● HP hs2350 HSPA+ Mobile Broadband Module

Support for no WWAN option

Support for WWAN after market option

External media cards Integrated Smart Card reader

Secure Digital (SD) Media reader slot with push-push technology, supporting the following
digital card formats:

● MultiMediaCard (MMC)

● MMC+

● Secure Digital (SD) Memory Card

● SDHC

● SDXC
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Category Description

Ports ● Audio-in (mono microphone)/audio-out (stereo headphone) combo jack

● Battery connector

● DisplayPort 1.1a

● Docking connector

● HP Smart AC adapter

● RJ-45 (Ethernet)

● USB 3.0 ports (2: 1 USB 3.0 charging port, 1 USB 3.0 port)

● VGA (Dsub 15-pin) supporting: 1920×1200 external resolution @ 75 Hz, hot plug and
unplug and autodetection for correct output to wide-aspect vs. standard aspect video

Keyboard/pointing
devices

Chiclet-style keyboard with numeric keypad (upper-left justified), dual-point, spill-resistant with
drain, durakeys, backlit (optional)

Gesture support: MultiTouch gestures enabled, two-finger scrolling, and pinch-zoom
as default

Taps enabled by default

Support for TouchPad with image sensor

Support for 2-way scroll

Power requirements Supports the following AC adapters:

● 65-W HP Smart AC adapter (PFC, RC/V, EM, 3-wire)

● 65-W HP Smart AC adapter (non-PFC, 3-wire)

● 65-W HP travel AC adapter (non-PFC, 3-wire)

 Support for 6-cell, 48-Wh, 2.20-Ah and 4-cell, 30-Wh, 2.00-Ah Li ion batteries

Security Support for security cable lock

Support for fingerprint reader and no fingerprint reader option

Support for Trusted Platform Module (TPM) 1.2 (Infineon, soldered down) and TPM Enhanced
Drive Lock (not supported in Asia and the People's Republic of China)

Integrated Smart Card reader (active)

Full volume encryption

Preboot authentication (password, Smart Card)

Operating system Preinstalled:

● Windows® 7 Home Premium 64- and 32-bit with Microsoft Basics

● Windows 7 Professional 64- and 32-bit with Microsoft Basics

● FreeDOS
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Category Description

 Preinstalled with Microsoft Office:

● Windows 7 Home Basic 32-bit with Office Starter (emerging markets only)

● Windows 7 Home Premium 64- and 32-bit with Office Starter (not available in Japan)

● Windows 7 Home Premium 64-bit with Office 2010 Personal (only in Japan)

● Windows 7 Home Premium 64-bit with Office 2010 Home & Business (only in Japan)

● Windows 7 Home Premium 64-bit with Office 2010 Personal (only in Japan)

● Windows 7 Home Premium 64-bit with Office 2010 Professional (only in Japan)

● Windows 7 Professional 64- and 32-bit with Office 2010 Starter (not available
in Japan)

● Windows 7 Professional 64- and 32-bit with Office 2010 Business & Home (only
in Japan)

● Windows 7 Professional 64- and 32-bit with Office 2010 Personal (only in Japan)

● Windows 7 Professional 64- and 32-bit with Office 2010 Professional (only in Japan)

 Restore media—DR-DVD:

● Windows 7

● Windows 7 with Windows DVD

 Restore media—OS-DVD:

● Windows 7 Home Basic 32-bit

● Windows 7 Home Premium 64- and 32-bit

● Windows 7 Professional 64- and 32-bit

 Certified:

● Microsoft WHQL

● SuSE Linux Enterprise 64-bit Service Pack 2
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Category Description

 Web-only support:

● Windows XP Pro 32-bit

● Windows 7 Enterprise 64- and 32-bit

● Windows 7 Ultimate 64- and 32-bit

Serviceability End user replaceable parts:

● AC adapter

● Battery

● Hard drive

● Keyboard

● Memory module

● Solid-state drive

● WLAN module

● WWAN module
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2 External component identification

Display

Item Component Description

(1) WLAN antennas (2)* Send and receive wireless signals to communicate
with WLANs (select models only).

(2) WWAN antennas (2)* Send and receive wireless signals to communicate
with WWANs (select models only).

(3) Internal microphones (2) Record sound.

(4) Webcam light (select models only) On: The webcam is in use.
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Item Component Description

(5) Webcam (select models only) Records video and captures still photographs.

To use the webcam, select Start > All Programs >
Communication and Chat > HP Webcam.

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately around
the antennas free from obstructions. To see wireless regulatory notices, see the section of the Regulatory, Safety, and
Environmental Notices that applies to your country or region.

Buttons and fingerprint reader (select models only)
NOTE: Your computer may look slightly different from the illustration in this section.

Item Component Description

(1) TouchPad on/off button Turns the TouchPad on and off.

(2) Fingerprint reader (select models only) Allows a fingerprint logon instead of a password logon.
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Keys
NOTE: Your computer may look slightly different from the illustration in this section.

Item Component Description

(1) esc key Displays system information when pressed in combination
with the fn key.

(2) fn key Executes frequently used system functions when pressed
in combination with a function key, the num lk key, the
esc key, or other keys.

(3) Windows logo key Displays the Windows Start menu.

(4) Function keys Execute frequently used system functions when pressed in
combination with the fn key.

(5) Embedded numeric keypad When the keypad is turned on, it can be used like an
external numeric keypad.

Each key on the keypad performs the function indicated
by the icon in the upper-right corner of the key.

(6) Windows applications key Displays a shortcut menu for items beneath the cursor.

(7) num lk key Turns the embedded numeric keypad on and off when
pressed in combination with the fn key.
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Lights
NOTE: Your computer may look slightly different from the illustration in this section.

Item Component Description

(1) Wireless light ● Off: An integrated wireless device, such as a
WLAN device, a WWAN device, and/or a
Bluetooth device, is on (select models only).

● Amber: All wireless devices are off
(select models only).

(2) Num lock light On: Num lock is on.

(3) Caps lock light On: Caps lock is on.

(4) TouchPad light ● Amber: The TouchPad is off.

● Off: The TouchPad is on.
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TouchPad
NOTE: Your computer may look slightly different from the illustration in this section.

Item Component Description

(1) Pointing stick Moves the pointer and selects or activates items on
the screen.

(2) Left pointing stick button Functions like the left button on an external mouse.

(3) TouchPad on/off button Turns the TouchPad on or off.

(4) TouchPad zone Moves the pointer and selects or activates items on
the screen.

(5) Left TouchPad button Functions like the left button on an external mouse.

(6) Right pointing stick button Functions like the right button on an external mouse.

(7) Right TouchPad button Functions like the right button on an external mouse.
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Front
NOTE: Your computer may look slightly different from the illustration in this section.

Item Component Description

(1) Wireless light ● White: An integrated wireless device, such as a
WLAN device and/or a WWAN device, is on.

● Amber: All wireless devices are off.

(2) Power light ● On: The computer is on.

● Blinking: The computer is in the Sleep state.

● Off: The computer is off or in Hibernation.

(3) AC adapter/Battery light ● Amber: The computer is connected to external
power and the battery is charged from 0 to
90 percent.

● White: The computer is connected to external power
and the battery is charged from 90 to 99 percent.

● Blinking amber: A battery that is the only available
power source has reached a low battery level.
When the battery reaches a critical battery level, the
battery light begins blinking rapidly.

● Off: The battery is fully charged.

(4) Hard drive light ● Blinking white: The hard drive is being accessed.

● Amber: HP 3D DriveGuard has temporarily parked
the hard drive.

(5) Speakers (2) Produce SRS Premium Sound.

NOTE: To use the SRS Premium Sound PRO software,
select Start > All Programs > SRS Premium
Sound.
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Left side
NOTE: Your computer may look slightly different from the illustration in this section.

Item Component Description

(1) Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a
deterrent, but it may not prevent the computer from being
mishandled or stolen.

(2) Power connector Connects an AC adapter.

(3) USB 3.0 port Connects optional USB 3.0 devices and provide
enhanced USB power performance.

(4) Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is
normal for the internal fan to cycle on and off during
routine operation.

(5) Smart Card reader (select models only) Supports optional smart cards.

(6) DisplayPort Connects an optional digital display device, such as a
high-performance monitor or projector.

(7) Audio-out (headphone) jack/Audio-in
(microphone) jack

Produces sound when connected to optional powered
stereo speakers, headphones, earbuds, a headset, or
television audio. Also connects an optional headset
microphone.

WARNING! To reduce the risk of personal injury,
adjust the volume before putting on headphones,
earbuds, or a headset. For additional safety information,
see the Regulatory, Safety, and Environmental Notices.

NOTE: When a device is connected to the jack, the
computer speakers are disabled.

NOTE: Be sure that the device cable has a 4-conductor
connector that supports both audio-out (headphone) and
audio-in (microphone).
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Right side
NOTE: Your computer may look slightly different from the illustration in this section.

Item Component Description

(1) Media Card reader Supports the following digital card formats:

● MultiMediaCard (MMC)

● MMC+

● Secure Digital (SD) Memory Card

● SDHC

● SDXC

(2) Power switch ● When the computer is off, slide the switch to turn on
the computer.

● When the computer is on, slide the switch briefly to
initiate Sleep.

● When the computer is in the Suspend state, slide the
switch briefly to exit Sleep.

● When the computer is in Hibernation, slide the
switch briefly to exit Hibernation.

CAUTION: Sliding and holding the power switch will
result in the loss of unsaved information.

If the computer has stopped responding and operating
system shutdown procedures are ineffective, press and
hold the power button for at least 5 seconds to turn off
the computer.

To learn more about your power settings:

● Select Start > Control Panel > System and
Security > Power Options.

● For more information, see the HP Notebook
Reference Guide.
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Item Component Description

(3) USB 3.0 charging port Connects an optional USB 3.0 device and provides
enhanced USB power performance. The USB 3.0
charging port can also charge select models of cell
phones and MP3 players, even when the computer is off.

NOTE: A charging USB port (also referred to as a
powered USB port) allows you to charge connected USB
devices. Standard USB ports will not charge all USB
devices or will charge using a low current. Some USB
devices require power and require you to use a
powered port.

(4) RJ-45 (network) jack Connects a network cable.

(5) External monitor port Connects an external VGA monitor or projector.
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Bottom
NOTE: Your computer may look slightly different from the illustration in this section.

Item Component Description

(1) Vents (2) Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is
normal for the internal fan to cycle on and off during
routine operation.

(2) Service cover Provides access to the hard drive bay, the WLAN module
slot, the WWAN module slot, and the memory
module slots.

CAUTION: To prevent an unresponsive system, replace
the wireless module only with a wireless module
authorized for use in the computer by the governmental
agency that regulates wireless devices in your country or
region. If you replace the module and then receive a
warning message, remove the module to restore
computer functionality, and then contact support through
Help and Support.

(3) Battery lock latch Releases the battery from the computer.

(4) SIM slot Supports a wireless subscriber identity module (SIM)
(select models only). The SIM slot is located inside the
battery bay.

(5) Battery bay Holds the battery.
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Item Component Description

(6) Docking connector Connects an optional docking device.

(7) Battery release latch Releases the battery.
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3 Illustrated parts catalog
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Service tag
When ordering parts or requesting information, provide the computer serial number and model number
provided on the service tag. It is necessary to remove the battery to obtain these numbers. See Battery
on page 45 for battery removal instructions.

Item Description Function

(1) Product name This is the product name affixed to the front of
the computer.

(2) Serial number (s/n) This is an alphanumeric identifier that is unique to
each product.

(3) Part number/Product number (p/n) This number provides specific information about the
product's hardware components. The part number
helps a service technician to determine what
components and parts are needed.

(4) Warranty period This number describes the duration of the warranty
period for the computer.

(5) Model description This is the alphanumeric identifier used to locate
documents, drivers, and support for the computer.

Service tag 19



Computer major components
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Item Component Spare part number

(1) Display assembly: The display assembly is spared at the subcomponent level only. For more display assembly
spare part information, see Display assembly subcomponents on page 26.

(2) Keyboard with backlight and pointing stick (includes keyboard cable, backlight cable, and pointing stick cable):

 For use in Belgium 693363-A41

 For use in Brazil 693363-201

 For use in Bulgaria 693363-261

 For use in Canada 693363-DB1

 For use in the Czech Republic and Slovakia 693363-FL1

 For use in Denmark 693363-081

 For use in France 693363-051

 For use in Germany 693363-041

 For use in Greece 693363-151

 For use in Hungary 693363-211

 For use in Iceland 693363-DD1

 For use in India 693363-D61

 For use in Israel 693363-BB1

 For use in Italy 693363-061

 For use in Japan 693363-291

 For use in Latin America 693363-161

 For use in the Netherlands 693363-B31

 For use in Norway 693363-091

 For use in Northwest Africa 693363-FP1

 For use in Portugal 693363-131

 For use in Romania 693363-271

 For use in Russia 693363-251

 For use in Saudi Arabia 693363-171

 For use in Slovenia 693363-BA1

 For use in South Korea 693363-AD1

 For use in Spain 693363-071

 For use in Sweden and Finland 693363-B71

 For use in Switzerland 693363-BG1

 For use in Taiwan 693363-AB1

 For use in Thailand 693363-281
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Item Component Spare part number

 For use in Turkey 693363-141

 For use in the United Kingdom and Singapore 693363-031

 For use in the United States 693363-001

 Keyboard with pointing stick (includes keyboard cable and pointing stick cable):

 For use in Belgium 693362-A41

 For use in Brazil 693362-201

 For use in Bulgaria 693362-261

 For use in Canada 693362-DB1

 For use in the Czech Republic and Slovakia 693362-FL1

 For use in Denmark 693362-081

 For use in France 693362-051

 For use in Germany 693362-041

 For use in Greece 693362-151

 For use in Hungary 693362-211

 For use in Iceland 693362-DD1

 For use in India 693362-D61

 For use in Israel 693362-BB1

 For use in Italy 693362-061

 For use in Japan 693362-291

 For use in Latin America 693362-161

 For use in the Netherlands 693362-B31

 For use in Norway 693362-091

 For use in Northwest Africa 693362-FP1

 For use in Portugal 693362-131

 For use in Romania 693362-271

 For use in Russia 693362-251

 For use in Saudi Arabia 693362-171

 For use in Slovenia 693362-BA1

 For use in South Korea 693362-AD1

 For use in Spain 693362-071

 For use in Sweden and Finland 693362-B71

 For use in Switzerland 693362-BG1
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Item Component Spare part number

 For use in Taiwan 693362-AB1

 For use in Thailand 693362-281

 For use in Turkey 693362-141

 For use in the United Kingdom and Singapore 693362-031

 For use in the United States 693362-001

(3) Top cover (includes TouchPad):

NOTE: The top cover spare part kit includes the TouchPad but does not include a TouchPad cable. The TouchPad
cable is included in the Cable Kit, spare part number 693306-001.

 For use on computer models equipped with a fingerprint reader 693317-001

 For use on computer models not equipped with a fingerprint reader 694507-001

(4) Smart Card reader assembly (includes cable) 693312-001

(5) Media Card reader assembly

NOTE: The Media Card reader assembly spare part kit does not include a Media
Card reader assembly cable. The Media Card reader assembly cable is included in
the Cable Kit, spare part number 693306-001.

693353-001

(6) Fingerprint reader board (includes bracket and cable) 693349-001

(7) System board (includes replacement thermal material):

 For use in all countries and regions except the People's Republic of China:

 Equipped with Intel Dual Core i7-3667U 1.80-GHz processor (SC turbo up to 2.90-
GHz), 4.0-MB L3 cache, 17 W

693360-001

 Equipped with Intel Dual Core i5-3427U 1.70-GHz processor (SC turbo up to 2.70-
GHz), 3.0-MB L3 cache, 17 W

693358-001

 Equipped with Intel Dual Core i5-3317U 1.70-GHz processor (SC turbo up to 2.60-
GHz), 3.0-MB L3 cache, 17 W

693357-001

 Equipped with Intel Dual Core i3-3217U 1.80-GHz processor, 3.0-MB L3 cache,
17 W

693356-001

 For use only in the People's Republic of China:

 Equipped with Intel Dual Core i7-3667U 1.80-GHz processor (SC turbo up to 2.90-
GHz), 4.0-MB L3 cache, 17 W

694511-001

 Equipped with Intel Dual Core i5-3427U 1.70-GHz processor (SC turbo up to 2.70-
GHz), 3.0-MB L3 cache, 17 W

694510-001

 Equipped with Intel Dual Core i5-3317U 1.70-GHz processor (SC turbo up to 2.60-
GHz), 3.0-MB L3 cache, 17 W

694509-001

 Equipped with Intel Dual Core i3-3217U 1.80-GHz processor, 3.0-MB L3 cache,
17 W

694508-001

(8) Heat sink (includes replacement thermal material) 693307-001

(9) Fan (includes cable) 693308-001
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Item Component Spare part number

(10) Speakers (include cables and 4 rubber isolators) 693354-001

(11) RTC battery 651038-001

(12) Power switch board (includes cable) 693352-001

(13) Audio board

NOTE: The audio board spare part kit does not include an audio board cable. The
audio board cable is included in the Cable Kit, spare part number 693306-001.

693351-001

(14) Battery (Li-ion):

 6-cell, 48-Wh, 2.2-Ah 685988-001

 4-cell, 30-Wh, 2.0-Ah 671604-001

(15) Base enclosure (includes battery release latch assembly, rubber feet, and service
cover release latch assembly)

693301-001

 Rubber Kit (not illustrated, includes base enclosure and display bezel screw covers) 693355-001

(16) Memory modules (PC3-12800, 1666-MHz, DDR3):

 8-GB 693313-001

 4-GB 641369-001

 2-GB 652972-001

(17) WWAN module:

 HP lt2523 LTE/HSPA+ Mobile Broadband Module 675793-001

 HP lt2522 LTE/EV-DO Mobile Broadband Module 675791-001

 HP un2430 EV-DO/HSPA Mobile Broadband Module 634400-001

 HP hs2350 HSPA+ Mobile Broadband Module 668969-001

(18) WLAN module:

 Atheros AR9462 802.11a/b/g/n 2×2 Bluetooth 4.0 Combo Adapter 676786-001

 Broadcom 4313GN 802.11b/g/n 1×1 WiFi and 20702 Bluetooth 4.0
Combo Adapter

657325-001

 Intel Centrino Advanced-N 6235 WLAN module 670292-001

 Intel Centrino Advanced-N 6205 WLAN module 631954-001

(19) Hard drive (does not include hard drive bracket, hard drive connector adapter, or screws):

 750-GB, 7200-rpm, 9.5-mm 633252-001

 500-GB, 7200-rpm, 9.5-mm self-encrypting drive 683801-001

 500-GB, 7200-rpm, 9.5-mm 634925-001

 320-GB, 7200-rpm, 9.5-mm 641672-001

 Hard Drive Hardware Kit (not illustrated, includes hard drive bracket, hard drive
connector adapter, and screws)

693350-001
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Item Component Spare part number

 Solid-state drive (not illustrated, does not include bracket, connector, or screws):

 256-GB SATA III self-encrypting solid-state drive 693545-001

 180-GB SATA III solid-state drive 693544-001

 160-GB SATA II solid-state drive 694673-001

 128-GB SATA III solid-state drive 693543-001

(20) Service cover 693315-001
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Display assembly subcomponents

Item Component Spare part number

(1) Display bezel:

 For use on computer models equipped with a webcam 693302-001

 For use on computer models not equipped with a webcam 693303-001

(2) 11.6 in, HD, LED, AG, SVA display panel 693361-001

 Display Cable Kit, includes: 693305-001

(3) Display panel cable and webcam/microphone module cable

(4) Webcam/microphone module 693318-001

 Microphone module 693313-001

 Antenna Kit, includes: 693299-001

(5a) WLAN antenna cables and transceivers

(5b) WWAN antenna cables and transceivers
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Item Component Spare part number

 Display Hinge Cover Kit, includes: 693310-001

(6a) Left and right display hinge caps

(6b) Left and right display hinge covers

(6c) Left and right display hinges

(7) Display enclosure 693300-001

(8) Display clutch cover 693311-001

 Display Panel Support Kit (not illustrated, includes display enclosure with pre-
installed WLAN antenna cables and transceivers and WWAN antenna cables and
transceivers)

693309-001
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Cable Kit

Item Component Spare part number

 Cable Kit, includes: 693306-001

(1) Audio board cable

(2) Media Card reader assembly cable

(3) TouchPad cable
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Mass storage devices

Item Description Spare part number

(1) Hard drive (does not include hard drive bracket, hard drive connector adapter, or screws):

 750-GB, 7200-rpm, 9.5-mm 633252-001

 500-GB, 7200-rpm, 9.5-mm SED 683801-001

 500-GB, 7200-rpm, 9.5-mm 634925-001

 320-GB, 7200-rpm, 9.5-mm 634862-001

 Hard Drive Hardware Kit, includes: 693350-001

(2a) Hard drive bracket

(2b) Hard drive connector adapter

 Hard drive bracket screws (not illustrated)

(3) Solid-state drive (does not include solid-state drive bracket, solid-state drive connector adapter, or screws):

 256-GB SATA III self-encrypting solid-state drive 693545-001

 180-GB SATA III solid-state drive 693544-001

 160-GB SATA II solid-state drive 694673-001

 128-GB SATA III solid-state drive 693543-001
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Miscellaneous parts

Component Spare part number

AC adapter:

65-W HP Smart AC adapter (PFC, RC/V, EM, 3-wire) 693710-001

65-W HP Smart AC adapter (non-PFC, 3-wire) 693711-001

65-W HP travel AC adapter (non-PFC, 3-wire) 693716-001

Power cord (3-pin, black, 1.83-m):

For use in Argentina 490371-D01

For use in Australia 490371-011

For use in Brazil 490371-202

For use in Denmark 490371-081

For use in Europe 490371-021

For use in India 490371-D61

For use in Israel 490371-BB1

For use in Japan 490371-291

For use in North America 490371-001

For use in the People's Republic of China 490371-AA1

For use in South Africa 490371-AR1

For use in South Korea 490371-AD1

For use in Switzerland 490371-111

For use in Taiwan 490371-AB1

For use in Thailand 490371-201

For use in the United Kingdom and Singapore 490371-031

Screw Kit 693316-001
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Sequential part number listing

Spare part number Description

490371-001 Power cord for use in North America (3-pin, black, 1.83-m)

490371-011 Power cord for use in Australia (3-pin, black, 1.83-m)

490371-021 Power cord for use in Europe (3-pin, black, 1.83-m)

490371-031 Power cord for use in the United Kingdom and Singapore (3-pin, black, 1.83-m)

490371-081 Power cord for use in Denmark (3-pin, black, 1.83-m)

490371-111 Power cord for use in Switzerland (3-pin, black, 1.83-m)

490371-201 Power cord for use in Thailand (3-pin, black, 1.83-m)

490371-202 Power cord for use in Brazil (3-pin, black, 1.83-m)

490371-291 Power cord for use in Japan (3-pin, black, 1.83-m)

490371-AA1 Power cord for use in the People's Republic of China (3-pin, black, 1.83-m)

490371-AB1 Power cord for use in Taiwan (3-pin, black, 1.83-m)

490371-AD1 Power cord for use in South Korea (3-pin, black, 1.83-m)

490371-AR1 Power cord for use in South Africa (3-pin, black, 1.83-m)

490371-BB1 Power cord for use in Israel (3-pin, black, 1.83-m)

490371-D01 Power cord for use in Argentina (3-pin, black, 1.83-m)

490371-D61 Power cord for use in India (3-pin, black, 1.83-m)

631954-001 Intel Centrino Advanced-N 6205 WLAN module

633252-001 750-GB, 7200-rpm, 9.5-mm hard drive (does not include hard drive bracket, hard drive connector
adapter, or screws)

NOTE: The hard drive bracket, hard drive connector adapter, and screws are included in the
Hard Drive Hardware Kit, spare part number 693350-001.

634400-001 HP un2430 EV-DO/HSPA Mobile Broadband Module

634925-001 500-GB, 7200-rpm, 9.5-mm hard drive (does not include hard drive bracket, hard drive connector
adapter, or screws)

NOTE: The hard drive bracket, hard drive connector adapter, and screws are included in the
Hard Drive Hardware Kit, spare part number 693350-001.

641369-001 4-GB memory module (PC3, 12800, 1600-MHz)

641672-001 320-GB, 7200-rpm, 9.5-mm hard drive (does not include hard drive bracket, hard drive connector
adapter, or screws)

NOTE: The hard drive bracket, hard drive connector adapter, and screws are included in the
Hard Drive Hardware Kit, spare part number 693350-001.

651038-001 RTC battery

652972-001 2-GB memory module (PC3, 12800, 1600-MHz)
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Spare part number Description

657325-001 Broadcom 4313GN 802.11b/g/n 1×1 WiFi and 20702 Bluetooth 4.0 Combo Adapter

668969-001 HP hs2350 HSPA+ Mobile Broadband Module

670034-001 8-GB memory module (PC3, 12800, 1600-MHz)

670292-001 Intel Centrino Advanced-N 6235 WLAN module

671604-001 4-cell, 30-Wh, 2.00-Ah, Li-ion battery

675791-001 HP lt2522 LTE/EV-DO Mobile Broadband Module

675793-001 HP lt2523 LTE/HSPA+ Mobile Broadband Module

676786-001 Atheros AR9462 802.11a/b/g/n 2×2 Bluetooth 4.0 Combo Adapter

683801-001 500-GB, 7200-rpm, 9.5-mm SED hard drive (does not include hard drive bracket, hard drive
connector adapter, or screws)

NOTE: The hard drive bracket, hard drive connector adapter, and screws are included in the
Hard Drive Hardware Kit, spare part number 693350-001.

685988-001 6-cell, 48-Wh, 2.20-Ah, Li-ion battery

693299-001 Antenna Kit (includes WLAN antenna cables and transceivers and WWAN antenna cables
and transceivers)

693300-001 Base enclosure (includes rubber feet, service cover release latch assembly, and battery release
latch assembly)

693301-001 Display enclosure

693302-001 Display bezel for use on computer models equipped with webcam

693303-001 Display bezel for use on computer models not equipped with webcam

693305-001 Display Cable Kit

693306-001 Cable Kit (includes audio board cable, SD Card reader board cable, and TouchPad cable)

693307-001 Heat sink (includes replacement thermal material)

693308-001 Fan (includes cable)

693309-001 Display Panel Support Kit (includes display enclosure with pre-installed WLAN antenna cables and
transceivers and WWAN antenna cables and transceivers)

693310-001 Display Hinge Cover Kit (includes left and right display hinges, left and right display hinge caps,
and left and right display hinge covers)

693311-001 Display clutch cover

693312-001 Smart Card reader assembly (includes cable)

693313-001 Microphone module

693315-001 Service cover

693316-001 Screw Kit
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Spare part number Description

693317-001 Top cover for use on computer models equipped with a fingerprint reader (includes TouchPad)

NOTE: The top cover spare part kit includes the TouchPad but does not include a TouchPad
cable. The TouchPad cable is included in the Cable Kit, spare part number 693306-001.

693318-001 Webcam/microphone module

693349-001 Fingerprint reader board (includes bracket and cable)

693350-001 Hard Drive Hardware Kit (includes hard drive bracket, hard drive connector adapter, and screws)

693351-001 Audio board

693352-001 Power switch board (includes cable)

693353-001 Media Card reader assembly

NOTE: The Media Card reader assembly spare part kit does not include a Media Card reader
assembly cable. The Media Card reader assembly cable is included in the Cable Kit, spare part
number 693306-001.

693354-001 Speakers (include cables and 4 rubber isolators)

693355-001 Rubber Kit (includes base enclosure and display bezel screw covers)

693356-001 System board equipped with Intel Dual Core i3-3217U 1.80-GHz processor for use in all countries
and regions except the People's Republic of China and the Ukraine (3.0-MB L3 cache, 17 W;
includes replacement thermal material)

693357-001 System board equipped with Intel Dual Core i5-3317U 1.70-GHz processor (SC turbo up to 2.60-
GHz) for use in all countries and regions except the People's Republic of China and the Ukraine
(3.0-MB L3 cache, 17 W; includes replacement thermal material)

693358-001 System board equipped with Intel Dual Core i5-3427U 1.70-GHz processor (SC turbo up to 2.70-
GHz) for use in all countries and regions except the People's Republic of China and the Ukraine
(3.0-MB L3 cache, 17 W; includes replacement thermal material)

693360-001 System board equipped with Intel Dual Core i7-3667U 1.80-GHz processor (SC turbo up to 2.90-
GHz) for use in all countries and regions except the People's Republic of China and the Ukraine
(4.0-MB L3 cache, 17 W; includes replacement thermal material)

693361-001 11.6 in, HD, LED, AG, SVA display panel

693362-001 Keyboard with pointing stick for use in the United States (includes keyboard cable and pointing
stick cable)

693362-031 Keyboard with pointing stick for use in the United Kingdom and Singapore (includes keyboard
cable and pointing stick cable)

693362-041 Keyboard with pointing stick for use in Germany (includes keyboard cable and pointing stick cable)

693362-051 Keyboard with pointing stick for use in France (includes keyboard cable and pointing stick cable)

693362-061 Keyboard with pointing stick for use in Italy (includes keyboard cable and pointing stick cable)

693362-071 Keyboard with pointing stick for use in Spain (includes keyboard cable and pointing stick cable)

693362-081 Keyboard with pointing stick for use in Denmark (includes keyboard cable and pointing stick cable)

693362-091 Keyboard with pointing stick for use in Norway (includes keyboard cable and pointing stick cable)

693362-131 Keyboard with pointing stick for use in Portugal (includes keyboard cable and pointing stick cable)
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Spare part number Description

693362-141 Keyboard with pointing stick for use in Turkey (includes keyboard cable and pointing stick cable)

693362-151 Keyboard with pointing stick for use in Greece (includes keyboard cable and pointing stick cable)

693362-161 Keyboard with pointing stick for use in Latin America (includes keyboard cable and pointing
stick cable)

693362-171 Keyboard with pointing stick for use in Saudi Arabia (includes keyboard cable and pointing
stick cable)

693362-201 Keyboard with pointing stick for use in Brazil (includes keyboard cable and pointing stick cable)

693362-211 Keyboard with pointing stick for use in Hungary (includes keyboard cable and pointing stick cable)

693362-251 Keyboard with pointing stick for use in Russia (includes keyboard cable and pointing stick cable)

693362-261 Keyboard with pointing stick for use in Bulgaria (includes keyboard cable and pointing stick cable)

693362-271 Keyboard with pointing stick for use in Romania (includes keyboard cable and pointing stick cable)

693362-281 Keyboard with pointing stick for use in Thailand (includes keyboard cable and pointing stick cable)

693362-291 Keyboard with pointing stick for use in Japan (includes keyboard cable and pointing stick cable)

693362-A41 Keyboard with pointing stick for use in Belgium (includes keyboard cable and pointing stick cable)

693362-AB1 Keyboard with pointing stick for use in Taiwan (includes keyboard cable and pointing stick cable)

693362-AD1 Keyboard with pointing stick for use in South Korea (includes keyboard cable and pointing
stick cable)

693362-B31 Keyboard with pointing stick for use in the Netherlands (includes keyboard cable and pointing
stick cable)

693362-B71 Keyboard with pointing stick for use in Sweden and Finland (includes keyboard cable and pointing
stick cable)

693362-BA1 Keyboard with pointing stick for use in Slovenia (includes keyboard cable and pointing stick cable)

693362-BB1 Keyboard with pointing stick for use in Israel (includes keyboard cable and pointing stick cable)

693362-BG1 Keyboard with pointing stick for use in Switzerland (includes keyboard cable and pointing
stick cable)

693362-D61 Keyboard with pointing stick for use in India (includes keyboard cable and pointing stick cable)

693362-DB1 Keyboard with pointing stick for use in Canada (includes keyboard cable and pointing stick cable)

693362-DD1 Keyboard with pointing stick for use in Iceland (includes keyboard cable and pointing stick cable)

693362-FL1 Keyboard with pointing stick for use in the Czech Republic and Slovakia (includes keyboard cable
and pointing stick cable)

693362-FP1 Keyboard with pointing stick for use in Northwest Africa (includes keyboard cable and pointing
stick cable)

693363-001 Keyboard with backlight and pointing stick for use in the United States (includes keyboard cable
and pointing stick cable)

693363-031 Keyboard with backlight and pointing stick for use in the United Kingdom and Singapore (includes
keyboard cable and pointing stick cable)
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Spare part number Description

693363-041 Keyboard with backlight and pointing stick for use in Germany (includes keyboard cable, backlight
cable, and pointing stick cable)

693363-051 Keyboard with backlight and pointing stick for use in France (includes keyboard cable, backlight
cable, and pointing stick cable)

693363-061 Keyboard with backlight and pointing stick for use in Italy (includes keyboard cable, backlight
cable, and pointing stick cable)

693363-071 Keyboard with backlight and pointing stick for use in Spain (includes keyboard cable, backlight
cable, and pointing stick cable)

693363-081 Keyboard with backlight and pointing stick for use in Denmark (includes keyboard cable, backlight
cable, and pointing stick cable)

693363-091 Keyboard with backlight and pointing stick for use in Norway (includes keyboard cable, backlight
cable, and pointing stick cable)

693363-131 Keyboard with backlight and pointing stick for use in Portugal (includes keyboard cable, backlight
cable, and pointing stick cable)

693363-141 Keyboard with backlight and pointing stick for use in Turkey (includes keyboard cable, backlight
cable, and pointing stick cable)

693363-151 Keyboard with backlight and pointing stick for use in Greece (includes keyboard cable, backlight
cable, and pointing stick cable)

693363-161 Keyboard with backlight and pointing stick for use in Latin America (includes keyboard cable,
backlight cable, and pointing stick cable)

693363-171 Keyboard with backlight and pointing stick for use in Saudi Arabia (includes keyboard cable,
backlight cable, and pointing stick cable)

693363-201 Keyboard with backlight and pointing stick for use in Brazil (includes keyboard cable, backlight
cable, and pointing stick cable)

693363-211 Keyboard with backlight and pointing stick for use in Hungary (includes keyboard cable, backlight
cable, and pointing stick cable)

693363-251 Keyboard with backlight and pointing stick for use in Russia (includes keyboard cable, backlight
cable, and pointing stick cable)

693363-261 Keyboard with backlight and pointing stick for use in Bulgaria (includes keyboard cable, backlight
cable, and pointing stick cable)

693363-271 Keyboard with backlight and pointing stick for use in Romania (includes keyboard cable, backlight
cable, and pointing stick cable)

693363-281 Keyboard with backlight and pointing stick for use in Thailand (includes keyboard cable, backlight
cable, and pointing stick cable)

693363-291 Keyboard with backlight and pointing stick for use in Japan (includes keyboard cable, backlight
cable, and pointing stick cable)

693363-A41 Keyboard with backlight and pointing stick for use in Belgium (includes keyboard cable, backlight
cable, and pointing stick cable)

693363-AB1 Keyboard with backlight and pointing stick for use in Taiwan (includes keyboard cable, backlight
cable, and pointing stick cable)
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Spare part number Description

693363-AD1 Keyboard with backlight and pointing stick for use in South Korea (includes keyboard cable,
backlight cable, and pointing stick cable)

693363-B31 Keyboard with backlight and pointing stick for use in the Netherlands (includes keyboard cable,
backlight cable, and pointing stick cable)

693363-B71 Keyboard with backlight and pointing stick for use in Sweden and Finland (includes keyboard
cable, backlight cable, and pointing stick cable)

693363-BA1 Keyboard with backlight and pointing stick for use in Slovenia (includes keyboard cable, backlight
cable, and pointing stick cable)

693363-BB1 Keyboard with backlight and pointing stick for use in Israel (includes keyboard cable, backlight
cable, and pointing stick cable)

693363-BG1 Keyboard with backlight and pointing stick for use in Switzerland (includes keyboard cable,
backlight cable, and pointing stick cable)

693363-D61 Keyboard with backlight and pointing stick for use in India (includes keyboard cable, backlight
cable, and pointing stick cable)

693363-DB1 Keyboard with backlight and pointing stick for use in Canada (includes keyboard cable, backlight
cable, and pointing stick cable)

693363-DD1 Keyboard with backlight and pointing stick for use in Iceland (includes keyboard cable, backlight
cable, and pointing stick cable)

693363-FL1 Keyboard with backlight and pointing stick for use in the Czech Republic and Slovakia (includes
keyboard cable, backlight cable, and pointing stick cable)

693363-FP1 Keyboard with backlight and pointing stick for use in Northwest Africa (includes keyboard cable,
backlight cable, and pointing stick cable)

693543-001 128-GB SATA III solid-state drive

693544-001 180-GB SATA III solid-state drive

693545-001 256-GB SATA III self-encrypting solid-state drive

693710-001 65-W HP Smart AC adapter (RC/V, EM, 3-wire)

693711-001 65-W HP Smart AC adapter (non-PFC, 3-wire)

693716-001 65-W HP travel AC adapter (non-PFC, 3-wire)

694507-001 Top cover for use on computer models not equipped with a fingerprint reader (includes TouchPad)

NOTE: The top cover spare part kit includes the TouchPad but does not include a TouchPad
cable. The TouchPad cable is included in the Cable Kit, spare part number 693306-001.

694508-001 System board equipped with Intel Dual Core i3-3217U 1.80-GHz processor for use only in the
People's Republic of China (3.0-MB L3 cache, 17 W; includes replacement thermal material)

694509-001 System board equipped with Intel Dual Core i5-3317U 1.70-GHz processor (SC turbo up to 2.60-
GHz) for use only in the People's Republic of China (3.0-MB L3 cache, 17 W; includes replacement
thermal material)

694510-001 System board equipped with Intel Dual Core i5-3427U 1.70-GHz processor (SC turbo up to 2.70-
GHz) for use only in the People's Republic of China (3.0-MB L3 cache, 17 W; includes replacement
thermal material)
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Spare part number Description

694511-001 System board equipped with Intel Dual Core i7-3667U 1.80-GHz processor (SC turbo up to 2.90-
GHz) for use only in the People's Republic of China (4.0-MB L3 cache, 17 W; includes replacement
thermal material)

694512-001 Processor bracket

694673-001 160-GB SATA II solid-state drive
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4 Removal and replacement
procedures

Preliminary replacement requirements

Tools required

You will need the following tools to complete the removal and replacement procedures:

● Flat-bladed screw driver

● Magnetic screw driver

● Phillips P0 and P1 screw drivers

Service considerations

The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts

CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts. Use
care when handling the plastic parts. Apply pressure only at the points designated in the
maintenance instructions.

Cables and connectors

CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that
they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with
extreme care; these cables tear easily.
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Drive handling

CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the
computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the
operating system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing an internal hard drive to products that have magnetic fields, such as monitors
or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”

Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.
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CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.

Before touching an electronic component, discharge static electricity by using the guidelines described
in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by
different activities.

CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

 Relative humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V 5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

● To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

● Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.

● Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

● Place items on a grounded surface before removing items from their containers.

● Always be properly grounded when touching a component or assembly.

● Store reusable ESD-sensitive parts from assemblies in protective packaging or
nonconductive foam.

● Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

● Cover the workstation with approved static-shielding material.

● Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

● Use conductive field service tools, such as cutters, screw drivers, and vacuums.

● When fixtures must directly contact dissipative surfaces, use fixtures made only of static-
safe materials.

● Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids
and Styrofoam.

● Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

● Avoid contact with pins, leads, or circuitry.

● Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

● When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm ±10% resistance in the ground cords. To provide proper ground,
wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,
use alligator clips to connect a wrist strap.

● When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive must be
worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

● Antistatic tape

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids

● Nonconductive foam

● Conductive tabletop workstations with ground cords of one megohm resistance

● Static-dissipative tables or floor mats with hard ties to the ground

● Field service kits

● Static awareness labels

● Material-handling packages

● Nonconductive plastic bags, tubes, or boxes

● Metal tote boxes

● Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level

Antistatic plastics Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V
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Component replacement procedures
This chapter provides removal and replacement procedures.

There are as many as 61 screws that must be removed, replaced, and/or loosened when servicing the
computer. Make special note of each screw size and location during removal and replacement.

Service tag

When ordering parts or requesting information, provide the computer serial number and model number
provided on the service tag. It is necessary to remove the battery to obtain these numbers. See Battery
on page 45 for battery removal instructions.

Item Component Description

(1) Product name This is the product name affixed to the front of
the computer.

(2) Serial number (s/n) This is an alphanumeric identifier that is unique to
each product.

(3) Part number/Product number (p/n) This number provides specific information about the
product’s hardware components. The part number helps
a service technician determine what components and
parts are needed.
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Item Component Description

(4) Warranty period This number describes the duration of the warranty
period for the computer.

(5) Model description This is the alphanumeric identifier used to locate
documents, drivers, and support for the computer.

Computer feet

The computer feet are adhesive-backed rubber pads. There are four rectangular rubber feet that attach
to the base enclosure in the locations illustrated below.

The feet are included in the Rubber Kit, spare part number 693355-001.
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Battery

Description Spare part number

6-cell, 48-Wh, 2.2-Ah 685988-001

4-cell, 30-Wh, 2.0-Ah 671604-001

Before disassembling the computer, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

Remove the battery:

1. Position the computer upside-down on a flat surface, with the battery bay toward you.

2. Slide the battery lock latch (1), and then slide the battery release latch (2) to release the battery.

3. Remove the battery (3) from the computer.

Install the battery by inserting it into the battery bay until you hear a click. The battery lock latch and the
battery release latch automatically reset when the battery is installed.
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SIM

NOTE: This section applies only to computer models with WWAN capability.

NOTE: If there is a SIM inserted in the SIM slot, it must be removed before disassembling the
computer. Be sure that the SIM is reinserted in the SIM slot after reassembling the computer.

Before removing the SIM, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 45).

Remove the SIM:

1. Press in on the SIM (1). (The SIM partially ejects from the SIM slot.)

2. Remove the SIM (2) from the SIM slot.

Reverse this procedure to install the SIM.
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Service cover

Description Spare part number

Service cover 693315-001

Before removing the service cover, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 45).

Remove the service cover:

1. Loosen the two Phillips PM2.0×5.5 screws (1) that secure the service cover to the computer.

2. Slide the service cover (2) forward to disengage the cover from the computer.

3. Remove the service cover (3) by lifting it straight up and away from the computer.

Reverse the removal procedures to install the service cover.
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Hard drive

NOTE: The hard drive spare part kit does not include the hard drive bracket, hard drive connector
adapter, or screws.

Description Spare part number

750-GB, 7200-rpm, 9.5-mm 633252-001

500-GB, 7200-rpm, 9.5-mm SED 683801-001

500-GB, 7200-rpm, 9.5-mm 634925-001

320-GB, 7200-rpm, 9.5-mm 641672-001

Hard Drive Hardware Kit (includes the hard drive bracket, hard drive connector adapter, and
screws)

693350-001

Before removing the hard drive, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 45).

5. Remove the service cover (see Service cover on page 47).

Remove the hard drive:

1. Loosen the four Phillips PM2.0×5.5 screws (1) that secure the hard drive to the computer.
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2. Use the hard drive tab (2) to disconnect the hard drive from the system board and remove the
hard drive from the computer.

3. If it is necessary to disassemble the hard drive, perform the following steps:

a. Position the hard drive with the connector toward you.

b. Disconnect the hard drive connector adapter (1) from the hard drive.

c. Remove the four Phillips PM2.9×4.1 screws (2) that secure the hard drive bracket to the
hard drive.

d. Lift the left side of the hard drive bracket (3) until it rests at an angle.

e. Remove the hard drive bracket (4) from the hard drive.

The hard drive bracket, hard drive connector adapter, and screws are available in the Hard
Drive Hardware Kit, spare part number 693350-001.
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Reverse this procedure to reassemble and install the hard drive.

Fingerprint reader board

Description Spare part number

Fingerprint reader board (includes bracket and cable) 693349-001

Before removing the fingerprint reader board, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 45).

5. Remove the service cover (see Service cover on page 47).

6. Remove the hard drive (see Hard drive on page 48).

Remove the fingerprint reader board:

1. Release the zero insertion force (ZIF) connector to which the fingerprint reader board cable is
attached, and then disconnect the fingerprint reader board cable (1) from the SD Card
reader board.

2. Remove the Phillips PM2.0×2.0 screw (2) that secures the fingerprint reader board bracket to the
top cover.
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3. Lift the rear edge of the fingerprint reader board bracket (3), and then remove the bracket.

4. Remove the fingerprint reader board and cable (4).

Reverse this procedure to install the fingerprint reader board.

WLAN module

Description Spare part number

Atheros AR9462 802.11a/b/g/n 2×2 Bluetooth 4.0 Combo Adapter 676786-001

Broadcom 4313GN 802.11b/g/n 1×1 WiFi and 20702 Bluetooth 4.0 Combo Adapter 657325-001

Intel Centrino Advanced-N 6235 WLAN module 670292-001

Intel Centrino Advanced-N 6205 WLAN module 631954-001

CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless
module authorized for use in the computer by the governmental agency that regulates wireless devices
in your country or region. If you replace the module and then receive a warning message, remove the
module to restore device functionality, and then contact technical support.

Before removing the WLAN module, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.
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4. Remove the battery (see Battery on page 45).

5. Remove the service cover (see Service cover on page 47).

Remove the WLAN module:

1. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

NOTE: The WLAN antenna cable labeled “1” connects to the WLAN module “Main” terminal
labeled “1”. The WLAN antenna cable labeled “2” connects to the WLAN module “Aux” terminal
labeled “2”. If the computer is equipped with an 802.11a/b/g/n WLAN module, the yellow
WLAN antenna cable connects to the middle terminal on the WLAN module.

2. Remove the Phillips PM2.0×3.0 screw (2) that secures the WLAN module to the base enclosure.
(The WLAN module tilts up.)

3. Remove the WLAN module (3) by pulling the module away from the slot at an angle.

NOTE: If the WLAN antenna cables are not connected to the terminals on the WLAN module, the
protective sleeves must be installed on the antenna connectors, as shown in the following illustration.
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Reverse this procedure to install the WLAN module.

WWAN module

NOTE: The WWAN module and the WLAN module are not interchangeable.

Description Spare part number

HP lt2523 LTE/HSPA+ Mobile Broadband Module 675793-001

HP lt2522 LTE/EV-DO Mobile Broadband Module 675791-001

HP un2430 EV-DO/HSPA Mobile Broadband Module 634400-001

HP hs2350 HSPA+ Mobile Broadband Module 668969-001

Before removing the WWAN module, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 45).

5. Remove the service cover (see Service cover on page 47).

Remove the WWAN module:

1. Disconnect the WWAN antenna cables (1) from the terminals on the WWAN module.

NOTE: The red WWAN antenna cable is connected to the WWAN module “Main” terminal.
The blue WWAN antenna cable is connected to the WWAN module “Aux” terminal.

2. Remove the Phillips PM2.0×3.0 screw (2) that secures the WWAN module to the base enclosure.
(The WWAN module tilts up.)

Component replacement procedures 53



3. Remove the WWAN module (3) by pulling the module away from the slot at an angle.

NOTE: If the WWAN antenna cables are not connected to the terminals on the WWAN module, the
protective sleeves must be installed on the antenna connectors, as shown in the following illustration.

Reverse this procedure to install the WWAN module.

54 Chapter 4   Removal and replacement procedures



Memory module

NOTE: Primary and expansion memory is installed in a stacked configuration in the bottom of
the computer.

Description Spare part number

8-GB memory module (PC3, 12800, 1600-MHz) 670034-001

4-GB memory module (PC3, 12800, 1600-MHz) 641369-001

2-GB memory module (PC3, 12800, 1600-MHz) 652972-001

Update BIOS before adding memory modules

Before adding new memory, make sure you update the computer to the latest BIOS.

CAUTION: Failure to update the computer to the latest BIOS prior to installing new memory may
result in various system problems.

To update BIOS:

1. Navigate to www.hp.com.

2. Click Support & Drivers > click Drivers & Software.

3. In the Enter a product name/number box, type the computer model information, and then
click Search.

4. Click the link for the computer model.

5. Select the operating system, and then click Next.

6. Under Step 2: Select a Download, click the BIOS link.

7. Click the link for the most recent BIOS.

8. Click the Download button, and then follow the on-screen instructions.

Before removing a memory module, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 45).

5. Remove the service cover (see Service cover on page 47).

Remove the memory module:

1. Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The edge of the module opposite the slot rises away from the computer.)
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2. Remove the memory module (2) by pulling the module away from the slot at an angle.

NOTE: The computer uses two memory slots. The top slot houses the expansion memory module.
The bottom slot houses the primary memory module.

Reverse this procedure to install a memory module.
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Fan

Description Spare part number

Fan (includes cable) 693308-001

Before removing the fan, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 45).

5. Remove the service cover (see Service cover on page 47).

Remove the fan:

1. Disconnect the fan cable (1) from the system board.

2. Remove the two Phillips PM2.0×3.4 screws (2) that secure the fan to the top cover.

3. Lift the left side of the fan (3) until it rests at an angle, and then remove the fan.

Reverse this procedure to install the fan.
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Keyboard

For use in country/region Spare part
number

For use in country/region Spare part
number

Keyboard with backlight and pointing stick (includes keyboard
cable, backlight cable, and pointing stick cable):

For use in the Netherlands 693363-B31

For use in Belgium 693363-A41 For use in Norway 693363-091

For use in Brazil 693363-201 For use in Northwest Africa 693363-FP1

For use in Bulgaria 693363-261 For use in Portugal 693363-131

For use in Canada 693363-DB1 For use in Romania 693363-271

For use in the Czech Republic
and Slovakia

693363-FL1 For use in Russia 693363-251

For use in Denmark 693363-081 For use in Saudi Arabia 693363-171

For use in France 693363-051 For use in Slovenia 693363-BA1

For use in Germany 693363-041 For use in South Korea 693363-AD1

For use in Greece 693363-151 For use in Spain 693363-071

For use in Hungary 693363-211 For use in Sweden and Finland 693363-B71

For use in Iceland 693363-DD1 For use in Switzerland 693363-BG1

For use in India 693363-D61 For use in Taiwan 693363-AB1

For use in Israel 693363-BB1 For use in Thailand 693363-281

For use in Italy 693363-061 For use in Turkey 693363-141

For use in Japan 693363-291 For use in the United Kingdom
and Singapore

693363-031

For use in Latin America 693363-161 For use in the United States 693363-001

Keyboard with pointing stick (includes keyboard cable and
pointing stick cable):

For use in the Netherlands 693362-B31

For use in Belgium 693362-A41 For use in Norway 693362-091

For use in Brazil 693362-201 For use in Northwest Africa 693362-FP1

For use in Bulgaria 693362-261 For use in Portugal 693362-131

For use in Canada 693362-DB1 For use in Romania 693362-271

For use in the Czech Republic
and Slovakia

693362-FL1 For use in Russia 693362-251

For use in Denmark 693362-081 For use in Saudi Arabia 693362-171

For use in France 693362-051 For use in Slovenia 693362-BA1

For use in Germany 693362-041 For use in South Korea 693362-AD1

For use in Greece 693362-151 For use in Spain 693362-071
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For use in country/region Spare part
number

For use in country/region Spare part
number

For use in Hungary 693362-211 For use in Sweden and Finland 693362-B71

For use in Iceland 693362-DD1 For use in Switzerland 693362-BG1

For use in India 693362-D61 For use in Taiwan 693362-AB1

For use in Israel 693362-BB1 For use in Thailand 693362-281

For use in Italy 693362-061 For use in Turkey 693362-141

For use in Japan 693362-291 For use in the United Kingdom
and Singapore

693362-031

For use in Latin America 693362-161 For use in the United States 693362-001

Before removing the keyboard, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 45).

5. Remove the service cover (see Service cover on page 47).

Remove the keyboard:

1. Loosen the four Phillips captive screws that secure the keyboard to the computer.

2. Rest and secure the computer on its left side.
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3. Partially open the computer.

4. Insert a screw driver or similar thin tool into the keyboard release opening in the battery bay, and
then press on the back of the keyboard until the keyboard disengages from the computer.

5. Turn the computer right-side up with the front toward you.

6. Open the computer.

7. Lift the rear edge of the keyboard (1) until the keyboard rests at an angle.

8. Slide the keyboard (2) toward the display until the tabs on the front edge of the keyboard
disengage from the slots in the top cover.
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9. Swing the top edge of the keyboard up and forward (3) until it rests upside down on the
palm rest.

NOTE: The keyboard backlight cable is present on select models only.

10. Release the ZIF connector (1) to which the keyboard backlight cable is attached, and then
disconnect the keyboard backlight cable (2) from the system board.

11. Release the ZIF connector (3) to which the keyboard cable is attached, and then disconnect the
keyboard cable (4) from the system board.
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12. Release the ZIF connector (5) to which the pointing stick cable is attached, and then disconnect
the pointing stick cable (6) from the system board.

13. Remove the keyboard.

Reverse this procedure to install the keyboard.
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Base enclosure

Description Spare part number

Base enclosure (includes battery release latch assembly, rubber feet, and service cover release
latch assembly)

693301-001

Before removing the base enclosure, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 45), and then remove the following components:

a. Service cover (see Service cover on page 47)

b. Hard drive (see Hard drive on page 48)

c. WLAN module (see WLAN module on page 51)

d. WWAN module (see WWAN module on page 53)

e. Keyboard (see Keyboard on page 58)

NOTE: When replacing the base enclosure, be sure to remove the following components from the
defective base enclosure and install them on the replacement base enclosure:

● Audio board (see Audio board on page 67)

● Speakers (see Speakers on page 68)

● Power switch board (see Power switch board on page 70)

Remove the base enclosure:

1. Close the computer.

2. Turn the computer upside down, with the front toward you.
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3. Disconnect the following cables from the system board:

(1) Display panel cable

(2) Power switch board cable

(3) Speaker cable

(4) Audio board cable

4. Release the display panel cable and wireless antenna cables (1) from the clips (2) and routing
channels built into the base enclosure.

64 Chapter 4   Removal and replacement procedures



5. Remove the two rubber screw covers (1) and (2) in the rear corners of the base enclosure.

The rubber screw covers are included in the Rubber Kit, spare part number 693355-001.

NOTE: The rubber screw covers are different sizes. The longer rubber screw cover (2) should be
installed in the rear/right corner.

6. Remove the ten Torx TM2.0×5.6 screws (3) that secure the base enclosure to the computer.

7. Remove the two Torx TM2.0×3.7 screws from the docking station alignment guide holes that
secure the base enclosure to the computer.

8. Position the computer with the front toward you.
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9. Disengage the base enclosure (1) from the top cover, making sure to guide the left-side wireless
antenna cables (2) through the base enclosure left-side opening (3) and the right-side wireless
antenna cables (4) through the base enclosure right-side opening (5).

10. Remove the base enclosure

Reverse this procedure to install the base enclosure.
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Audio board

NOTE: The audio board spare part kit does not include an audio board cable. The audio board
cable is included in the Cable Kit, spare part number 693306-001.

Description Spare part number

Audio board 693351-001

Before removing the audio board, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 45), and then remove the following components:

a. Service cover (see Service cover on page 47)

b. Hard drive (see Hard drive on page 48)

c. WLAN module (see WLAN module on page 51)

d. WWAN module (see WWAN module on page 53)

e. Keyboard (see Keyboard on page 58)

f. Base enclosure (see Base enclosure on page 63)

Remove the audio board:

1. Turn the base enclosure right side up, with the front toward you.

2. Remove the Phillips PM2.0×3.7 screw (1) that secures the audio board to the base enclosure.

3. Lift the right side of the audio board (2) until it rests at an angle.
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4. Remove the audio board (3) and cable.

Reverse this procedure to install the audio board.

Speakers

Description Spare part number

Speakers (include cables and 4 rubber isolators) 655792-001

Before removing the speakers, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 45), and then remove the following components:

a. Service cover (see Service cover on page 47)

b. Hard drive (see Hard drive on page 48)

c. WLAN module (see WLAN module on page 51)

d. WWAN module (see WWAN module on page 53)

e. Keyboard (see Keyboard on page 58)

f. Base enclosure (see Base enclosure on page 63)
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Remove the speakers:

1. Turn the base enclosure right side up, with the front toward you.

2. Release the speaker cable (1) from the clips built into the base enclosure.

3. Remove the four Phillips PM2.5×5.9 screws (2) that secure the speakers to the base enclosure.

4. Remove the speakers (3).

NOTE: The speakers include four rubber isolators that are installed in the screw holes (4). These
isolators are crucial to the performance of the speakers.

Reverse this procedure to install the speakers.
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Power switch board

Description Spare part number

Power switch board (includes cable) 693352-001

Before removing the power switch board, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 45), and then remove the following components:

a. Service cover (see Service cover on page 47)

b. Hard drive (see Hard drive on page 48)

c. WLAN module (see WLAN module on page 51)

d. WWAN module (see WWAN module on page 53)

e. Keyboard (see Keyboard on page 58)

f. Base enclosure (see Base enclosure on page 63)

Remove the power switch board:

1. Turn the base enclosure right side up, with the front toward you.

2. Remove the Phillips PM2.0×3.4 screw (1) that secures the power switch board to the
base enclosure.
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3. Remove the power switch board (2).

Reverse this procedure to install the power switch board.

Media Card reader assembly

NOTE: The Media Card reader assembly spare part kit does not include a Media Card reader
assembly cable. The Media Card reader assembly cable is included in the Cable Kit, spare part
number 693306-001.

Description Spare part number

Media Card reader assembly 693353-001

Before removing the Media Card reader assembly, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 45), and then remove the following components:

a. Service cover (see Service cover on page 47)

b. Hard drive (see Hard drive on page 48)

c. WLAN module (see WLAN module on page 51)

d. WWAN module (see WWAN module on page 53)
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e. Keyboard (see Keyboard on page 58)

f. Base enclosure (see Base enclosure on page 63)

Remove the Media Card reader assembly:

1. Release the ZIF connector to which the fingerprint reader board cable is attached, and then
disconnect the fingerprint reader board cable (1) from the Media Card reader assembly.

2. Remove the two Phillips PM2.0×3.4 screws (1) that secure the Media Card reader assembly to
the top cover.

3. Lift the front edge of the Media Card reader assembly (1), and then swing the assembly (2) up
and to the left.
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4. Release the ZIF connector to which the Media Card reader assembly cable is attached, and then
disconnect the Media Card reader assembly cable (3) from the Media Card reader assembly.

5. Remove the Media Card reader assembly.

Reverse this procedure to install the Media Card reader assembly.

RTC battery

Description Spare part number

RTC battery 651038-001

Before removing the RTC battery, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 45), and then remove the following components:

a. Service cover (see Service cover on page 47)

b. Hard drive (see Hard drive on page 48)

c. WLAN module (see WLAN module on page 51)

d. WWAN module (see WWAN module on page 53)
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e. Keyboard (see Keyboard on page 58)

f. Base enclosure (see Base enclosure on page 63)

Remove the RTC battery:

▲ Use a thin, non-conductive tool (1) to remove the RTC battery (2) from the socket on the
system board.

Reverse this procedure to install the RTC battery. When installing the RTC battery, make sure the “+”
sign faces up.
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System board

NOTE: The system board spare part kit includes replacement thermal material.

Description Spare part number

For use in all countries and regions except the People's Republic of China:

Equipped with Intel Dual Core i7-3667U 1.80-GHz processor (SC turbo up to 2.90-GHz), 4.0-MB
L3 cache, 17 W

693360-001

Equipped with Intel Dual Core i5-3427U 1.70-GHz processor (SC turbo up to 2.70-GHz), 3.0-MB
L3 cache, 17 W

693358-001

Equipped with Intel Dual Core i5-3317U 1.70-GHz processor (SC turbo up to 2.60-GHz), 3.0-MB
L3 cache, 17 W

693357-001

Equipped with Intel Dual Core i3-3217U 1.80-GHz processor, 3.0-MB L3 cache, 17 W 693356-001

For use only in the People's Republic of China:

Equipped with Intel Dual Core i7-3667U 1.80-GHz processor (SC turbo up to 2.90-GHz), 4.0-MB
L3 cache, 17 W

694511-001

Equipped with Intel Dual Core i5-3427U 1.70-GHz processor (SC turbo up to 2.70-GHz), 3.0-MB
L3 cache, 17 W

694510-001

Equipped with Intel Dual Core i5-3317U 1.70-GHz processor (SC turbo up to 2.60-GHz), 3.0-MB
L3 cache, 17 W

694509-001

Equipped with Intel Dual Core i3-3217U 1.80-GHz processor, 3.0-MB L3 cache, 17 W 694508-001

Before removing the system board, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 45), and then remove the following components:

a. Service cover (see Service cover on page 47)

b. Hard drive (see Hard drive on page 48)

c. WLAN module (see WLAN module on page 51)

d. WWAN module (see WWAN module on page 53)

e. Fan (see Fan on page 57)

f. Keyboard (see Keyboard on page 58)

g. Base enclosure (see Base enclosure on page 63)
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NOTE: When replacing the system board, be sure that the following components are removed from
the defective system board and installed on the replacement system board:

● SIM (see SIM on page 46)

● Memory module (see Memory module on page 55)

● RTC battery (see RTC battery on page 73)

● Heat sink (see Heat sink on page 77)

Remove the system board:

1. Remove the two Phillips PM2.0×3.4 screws (1) that secure the system board to the top cover.

2. Lift the rear edge of the system board (2) and swing it up and forward until it rests upside down in
front of the computer.

3. Release the ZIF connector to which the TouchPad cable is connected, and then disconnect the
TouchPad cable (1) from the system board.
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4. Release the ZIF connector to which the Smart Card reader board cable is connected, and then
disconnect the Smart Card reader board cable (2) from the system board.

5. Remove the system board.

Reverse this procedure to install the system board.

Heat sink

Description Spare part number

Heat sink (includes replacement thermal material) 693307-001

Before removing the heat sink, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 45), and then remove the following components:

a. Service cover (see Service cover on page 47)

b. Hard drive (see Hard drive on page 48)

c. WLAN module (see WLAN module on page 51)

d. WWAN module (see WWAN module on page 53)

e. Fan (see Fan on page 57)

f. Keyboard (see Keyboard on page 58)
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g. Base enclosure (see Base enclosure on page 63)

h. System board (see System board on page 75)

Remove the heat sink:

1. Following the 1, 2, 3, 4 sequence stamped into the heat sink, loosen the four captive Philllips
screws (1) that secure the heat sink to the system board.

2. Remove the heat sink (2).

NOTE: Due to the adhesive quality of the thermal material located between the heat sink and
the system board components, it may be necessary to move the heat sink from side to side to
detach it.

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the heat sink and
the system board components each time the heat sink is removed. Replacement thermal material is
included with the heat sink and system board spare part kits. Thermal paste is used on the
processor (1) and the heat sink section (2) that services it.
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Reverse this procedure to install the heat sink.

Smart Card reader assembly

Description Spare part number

Smart Card reader assembly (includes cable) 693312-001

Before removing the Smart Card reader assembly, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 45), and then remove the following components:

a. Service cover (see Service cover on page 47)

b. Hard drive (see Hard drive on page 48)

c. WLAN module (see WLAN module on page 51)

d. WWAN module (see WWAN module on page 53)

e. Fan (see Fan on page 57)

f. Keyboard (see Keyboard on page 58)

g. Base enclosure (see Base enclosure on page 63)

h. System board (see System board on page 75)

Remove the Smart Card reader assembly:

1. Remove the two Phillips PM2.0×3.4 screws (1) that secure the Smart Card reader assembly to the
top cover.

2. Slide the Smart Card reader assembly (2) to the left to release it from the clips built into the
top cover.
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3. Remove the Smart Card reader assembly (3).

Reverse this procedure to install the Smart Card reader assembly.

Top cover

NOTE: The top cover spare part kit includes the TouchPad. The TouchPad cable is included in the
Cable Kit, spare part number 693306-001.

Description Spare part number

For use on computer models equipped with a fingerprint reader 693317-001

For use on computer models not equipped with a fingerprint reader 694507-001

NOTE: The display assembly is spared at the subcomponent level only. For more display assembly
spare part information, see the individual removal subsections.

Before removing the display assembly, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 45), and then remove the following components:

a. Service cover (see Service cover on page 47)

b. Hard drive (see Hard drive on page 48)

c. WLAN module (see WLAN module on page 51)
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d. WWAN module (see WWAN module on page 53)

e. Fan (see Fan on page 57)

f. Keyboard (see Keyboard on page 58)

g. Base enclosure (see Base enclosure on page 63)

h. System board (see System board on page 75)

NOTE: When replacing the top cover, be sure to remove the following components from the
defective top cover and install them on the replacement top cover:

● Fingerprint reader board (see Fingerprint reader board on page 50)

● Media Card reader assembly (see Media Card reader assembly on page 71)

● Smart Card reader assembly (see Smart Card reader assembly on page 79)

Remove the top cover:

1. Release the left-side wireless antenna cables (1) from the clips (2) and routing channel built into
the top cover.

2. Release the display panel cable (3) and right-side wireless antenna cables from the clips (4) and
routing channel built into the top cover.

3. Remove the two Phillips PM2.0×5.0 screws (5) that secure the top cover to the display assembly.
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4. Disengage the top cover (1) from the display assembly, making sure to guide the left-side wireless
antenna cables (2) through the top cover left-side opening (3) and the display panel cable (4)
and the right-side wireless antenna cables through the top cover right-side opening (5).

Reverse this procedure to install the top cover.
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Display assembly subcomponents

NOTE: The display assembly is spared at the subcomponent level only. For more display assembly
spare part information, see the individual removal subsections.

To access the display assembly subcomponents, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 45), and then remove the following components:

a. Service cover (see Service cover on page 47)

b. Hard drive (see Hard drive on page 48)

c. Optical drive (see Hard drive on page 48)

d. WLAN module (see WLAN module on page 51)

e. WWAN module (see WWAN module on page 53)

f. Fan (see Fan on page 57)

g. Keyboard (see Keyboard on page 58)

h. Base enclosure (see Base enclosure on page 63)

i. System board (see System board on page 75)

1. If it is necessary to replace the display bezel or any of the display assembly subcomponents:

a. Remove the display bezel screw covers (1).

The display bezel screw covers are available in the Rubber Kit, spare part number
693355-001.

b. Remove the two Phillips PM2.0×4.2 screws (2) that secure the display bezel and the display
clutch cover to the display assembly.
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c. Remove the display clutch cover (3).

The display clutch cover is available using spare part number 693311-001.

d. Flex the inside edges of the bottom edge (1), the left and right sides (2), and the
top edge (3) of the display bezel until the bezel disengages from the display enclosure.

e. Remove the display bezel (4).

The display bezel is available using spare part numbers 693302-001 (for use on computer
models equipped with a webcam) and 693303-001 (for use on computer models not
equipped with a webcam).

84 Chapter 4   Removal and replacement procedures



2. If it is necessary to replace the display hinges, display hinge covers, and/or display hinge caps:

a. Remove the two Phillips PM2.0×4.2 screws (1) that secure the display hinge to the
display enclosure.

b. Remove the display hinge (2) from the display enclosure.

c. Remove the display hinge cap (3) from the display hinge.

d. Remove the Phillips PM2.0×4.2 screw (4) that secures the display hinge cover to the
display hinge.

e. Remove the display hinge cover (5) from the display hinge.

The display hinges, display hinge caps, and display hinge covers are included in the Display
Hinge Cover Kit, spare part number 693310-001.
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3. If it is necessary to replace the display panel:

a. Remove the four Phillips PM2.0×4.2 screws (1) that secure the display panel to the
display enclosure.

b. Release the display panel cable (1) from the clips (2) and routing channel built into the
bottom edge of the display enclosure.

CAUTION: Before turning the display panel upside down, make sure the work surface is
clear of tools, screws, and any other foreign objects. Failure to follow this caution can result
in damage to the display panel.

c. Lift the top edge of the display panel (3) and swing it up and forward until it rests upside
down in front of the display enclosure.

d. Release the adhesive support strip (4) that secures the display panel cable to the
display panel.

e. Release the support bar (5) that secures the display panel cable to the display panel.
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f. Disconnect the display panel cable (6) from the display panel.

g. Remove the display panel.

The display panel is available using spare part number 693361-001.

4. If it is necessary to replace the display panel cable:

a. Disconnect the display panel cable (1) from the webcam/microphone module.

b. Remove the display panel cable (2).

The display panel cable is included in the Display Cable Kit, spare part number
693305-001.
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5. If it is necessary to replace the webcam/microphone module:

CAUTION: Handle the webcam/microphone module with caution. The module has a thin
profile and is susceptible to damage when not handled carefully.

a. Detach the webcam/microphone module (1) from the display enclosure. (The webcam/
microphone module is attached to the display enclosure with double-sided tape.)

b. Detach the webcam/microphone module cable (2) from the display enclosure. (The
webcam/microphone module cable is attached to the display enclosure with double-
sided tape.)

c. Disconnect the webcam/microphone module cable (3) from the webcam/
microphone module.

d. Remove the webcam/microphone module (4).

The webcam/microphone module is available using spare part number 693318-001. The
microphone module is available using spare part number 693313-001.

6. If it is necessary to replace the WLAN antenna cables and transceivers:

a. Detach the WLAN antenna transceivers (1) from the display enclosure. (The WLAN antenna
transceivers are attached to the display enclosure with double-sided tape.)

b. Release the WLAN antenna cables from the clips (2) and routing channel built into the
display enclosure.
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c. Remove the WLAN antenna cables and transceivers (3). The WLAN antenna cables and
transceivers are included in the Antenna Kit, spare part number 693299-001.

7. If it is necessary to replace the WWAN antenna cables and transceivers:

a. Detach the WWAN antenna transceivers (1) from the display enclosure. (The WWAN
antenna transceivers are attached to the display enclosure with double-sided tape.)

b. Release the WWAN antenna cables from the clips (2) and routing channel built into the
display enclosure.
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c. Remove the WWAN antenna cables and transceivers (3). The WWAN antenna cables and
transceivers are included in the Antenna Kit, spare part number 693299-001.

Reverse this procedure to reassemble and install the display assembly.
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5 Computer Setup (BIOS) and
Advanced System Diagnostics

Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input
and output devices on the system (such as disk drives, display, keyboard, mouse, and printer).
Computer Setup includes settings for the types of peripherals installed, the startup sequence of the
computer, and the amount of system and extended memory.

NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer
from operating properly.

Starting Computer Setup
NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.
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Using Computer Setup

Navigating and selecting in Computer Setup

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or
the keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter Computer Setup.

To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.

– or –

● To save your changes and exit Computer Setup menus, click the Save icon in the lower-left corner
of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Save Changes and Exit, and then
press enter.

Your changes go into effect when the computer restarts.
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Restoring factory settings in Computer Setup

NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Use a pointing device or the arrow keys to select File > Restore Defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then
follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the
factory settings.

Updating the BIOS
Updated versions of the BIOS may be available on the HP Web site.

Most BIOS updates on the HP Web site are packaged in compressed files called SoftPaqs.

Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.

Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed
on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed as follows:

1. Start Computer Setup.

2. Use a pointing device or the arrow keys to select File > System Information.

3. To exit Computer Setup without saving your changes, click the Exit icon in the lower-left corner of
the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.
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NOTE: You can also determine the BIOS version by turning on or restarting the computer, pressing
the esc key while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the
screen, and then pressing the f1 key. Follow the on-screen instructions to exit this screen.

Downloading a BIOS update

CAUTION: CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation,
download and install a BIOS update only when the computer is connected to reliable external power
using the AC adapter. Do not download or install a BIOS update while the computer is running on
battery power, docked in an optional docking device, or connected to an optional power source.
During the download and installation, follow these instructions:

Do not disconnect power from the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate Suspend or Hibernation.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. Open your Web browser. For U.S. support, go to http://www.hp.com/go/contactHP.
For worldwide support, go to http://welcome.hp.com/country/us/en/wwcontact_us.html.

2. Follow the on-screen instructions to identify your computer and access the BIOS update you want
to download.

3. Click the option for software and driver downloads, type your computer model number in the
product box, and then press enter. Follow the on-screen instructions to identify your computer and
access the BIOS update you want to download.

4. Click your specific product from the models listed.

5. Click the appropriate operating system.

6. Go to the BIOS section and download the BIOS software package.

7. Follow the installation instructions as provided with the downloaded BIOS software package.

NOTE: After a message on the screen reports a successful installation, you can delete the
downloaded file from your hard drive.
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Using Advanced System Diagnostics
Advanced System Diagnostics allows you to run diagnostic tests to determine if the computer hardware
is functioning properly. The following diagnostic tests are available in Advanced System Diagnostics:

● Start-up test—This test analyzes the main computer components that are required to start
the computer.

● Run-in test—This test repeats the start-up test and checks for intermittent problems that the start-up
test does not detect.

● Hard disk test—This test analyzes the physical condition of the hard drive, and then checks all
data in every sector of the hard drive. If the test detects a damaged sector, it attempts to move the
data to a good sector.

● Memory test—This test analyzes the physical condition of the memory modules. If it reports an
error, replace the memory modules immediately.

● Battery test—This test analyzes the condition of the battery and calibrates the battery if necessary.
If the battery fails the test, contact support to report the issue and purchase a replacement battery.

● System Tune-Up—This group of additional tests checks your computer to make sure that the main
components are functioning correctly. System Tune-Up runs longer and more comprehensive tests
on memory modules, hard drive SMART attributes, the hard drive surface, the battery (and battery
calibration), video memory, and the WLAN module status.

You can view system information and error logs in the Advanced System Diagnostics window.

To start Advanced System Diagnostics:

1. 1. Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is
displayed in the lower-left corner of the screen, press esc. When the Startup Menu is displayed,
press f2.

2. Click the diagnostic test you want to run, and then follow the on-screen instructions.

NOTE: If you need to stop a diagnostics test while it is running, press esc.
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6 Specifications

Computer specifications

 Metric U.S.

Dimensions

Width 29.20 cm 11.50 in

Depth 19.20 cm 7.56 in

Height 2.65 cm 1.04 in

Weight (equipped with 4-cell battery, hard drive, 1
memory module, and WLAN module)

1.33 kg 2.93 lbs

Input power

Operating voltage and current 18.5 V dc @ 3.5 A - 65 W

18.5 V dc @ 3.5 A - 65 W, Slim Adapter

19.5 V dc @ 3.33 A - 65 W

Temperature

Operating 5°C to 35°C 41°F to 95°F

Nonoperating -20°C to 60°C -4°F to 140°F

Relative humidity (noncondensing)

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)

Operating -15 m to 3,048 m -50 ft to 10,000 ft

Nonoperating -15 m to 12,192 m -50 ft to 40,000 ft

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The device operates well within this
range of temperatures.
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11.6-inch SGA display specifications

 Metric U.S.

Dimensions

Height 14.70 cm 5.79 in

Width 25.90 cm 10.20 in

Diagonal 29.50 cm 11.61 in

Number of colors Up to 16.8 million

Contrast ratio 200:1 (typical)

Brightness 200 nits (typical)

Pixel resolution

Pitch 0.197 × 0.197 mm

Format 1366 × 768

Configuration RGB vertical stripe

Backlight LED

Character display 80 × 25

Total power consumption 2.0 W

Viewing angle ±65° horizontal, ±50° vertical (typical)
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Hard drive specifications

 750-GB* 500-GB* 320-GB*

Dimensions

Height 9.5 mm 9.5 mm 9.5 mm

Length 100.2 mm 100.4 mm 100.4 mm

Width 69.9 mm 69.9 mm 69.9 mm

Weight 110 g 110 g 110 g

Interface type SATA SATA SATA

Transfer rate

Synchronous (maximum) 1.1 GB/sec 1.1 GB/sec 1.1 GB/sec

Security ATA security ATA security ATA security

Seek times (typical read, including setting)

Single track 2.0 ms 1.5 ms 1.5 ms

Average (read/write) 12/16 ms 11/13 ms 11/13 ms

Maximum 22 ms 22 ms 22 ms

Logical blocks 1,465,149,168 976,773,168 628,142,448

Disk rotational speed 7200 rpm 7200 rpm 7200 rpm

Operating temperature 0°C to 60°C (32°F to 140°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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7 Backup and recovery

To protect your information, use Windows Backup and Restore to back up individual files and folders,
back up your entire hard drive (select models only), create system repair discs (select models only) with
the installed optical drive (select models only) or an optional external optical drive, or create system
restore points. In case of system failure, you can use the backup files to restore the contents of
your computer.

Windows Backup and Restore provides the following options:

● Creating a system repair disc (select models only) by using the installed optical drive (select
models only) or an optional external optical drive

● Backing up your information

● Creating a system image (select models only)

● Scheduling automatic backups (select models only)

● Creating system restore points

● Recovering individual files

● Restoring the computer to a previous state

● Recovering information using recovery tools

NOTE: For detailed instructions, perform a search for these topics in Help and Support.

In case of system instability, HP recommends that you print the recovery procedures and save them for
later use.

NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. See Help and Support for more information.
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Creating recovery media with HP Recovery
Disc Creator

HP Recovery Disc Creator is a software program that offers an alternative way to create recovery
media. After you successfully set up the computer, you can create recovery media using HP Recovery
Disc Creator. This recovery media allows you to reinstall your original operating system as well as
select drivers and applications if the hard drive becomes corrupted.

HP Recovery Disc Creator can create two kinds of recovery DVDs as follows:

● Windows DVD—Installs the operating system without additional drivers or applications.

● Driver DVD—Installs specific drivers and applications only, in the same way that the HP Software
Setup utility installs drivers and applications.

Creating recovery media

NOTE: The Windows DVD can be created only once. Thereafter, the option to create that media will
not be available.

1. Select Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.

2. Select Driver DVD or Windows DVD.

3. From the drop-down menu, select the drive for burning the recovery media.

4. Click the Burn button to start the burning process.

Backing up your information
Recovery after a system failure is as good as your most recent backup. Immediately after setting up the
computer, you should create system repair discs (select models only) using the installed optical drive
(select models only) or an optional external optical drive and back up your system. As you add new
software and data files, you should continue to back up your system on a regular basis to maintain a
reasonably current backup. The system repair discs (select models only) are used to start up (boot) the
computer and repair the operating system in case of system instability or failure. Your initial and
subsequent backups allow you to restore your data and settings if a failure occurs.

You can back up your information to an optional external hard drive, a network drive, or discs.

Note the following when backing up:

● Store personal files in the Documents library, and back it up regularly.

● Back up templates that are stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.
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● When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend on the
type of optical drive you are using.

NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

● When backing up to discs, number each disc before inserting it into the external drive.

To create a backup using Backup and Restore:

NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of
the computer.

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to set up your backup, create a system image (select models
only), or create a system repair disc (select models only).

Performing a system recovery
In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

● f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the factory.

NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair discs
you previously created (select models only), you must purchase a Windows 7 operating system DVD to
reboot the computer and repair the operating system. For additional information, see the Using a
Windows 7 operating system DVD (purchased separately) section.

Using the Windows recovery tools

To recover information you previously backed up:

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to recover your system settings, your computer (select models
only), or your files.

To recover your information using Startup Repair, follow these steps:
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CAUTION: Some Startup Repair options completely erase hard drive contents and reformat the hard
drive. All files you have created and any software installed on the computer are permanently removed.
When reformatting is complete, the recovery process restores the operating system, as well as the
drivers, software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the Windows partition.

To check for the Windows partition, select Start > Computer.

3. If the Windows partition is listed, restart the computer, and then press f8 before the Windows
operating system loads.

4. Select Startup Repair.

5. Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support.

Using f11 recovery tools

CAUTION: Using f11 recovery tools completely erases hard drive contents and reformats the hard
drive. All files you have created and any software installed on the computer are permanently removed.
The f11 recovery tool reinstalls the operating system and HP programs and drivers that were installed at
the factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition: click Start, right-click Computer,
click Manage, and then click Disk Management.

NOTE: If the HP Recovery partition has been deleted, the f11 restore option will not function.
You must recover your operating system and programs using the Windows 7 operating system
DVD and the Driver Recovery disc (both purchased separately) if the Windows partition and the
HP Recovery partition are not listed. For additional information, see the Using a Windows 7
operating system DVD (purchased separately) section.

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the “Press the
ESC key for Startup Menu” message is displayed at the bottom of the screen.

4. Press f11 while the “Press <F11>” for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.
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Using a Windows 7 operating system DVD (purchased separately)

To order a Windows 7 operating system DVD, go to the HP website. For U.S. support, go to
http:// www.hp.com/go/contactHP. For worldwide support, go to http://welcome.hp.com/country/
us/en/ wwcontact_us.html. You can also order the DVD by calling support. For contact information,
see the Worldwide Telephone Numbers booklet included with the computer.

CAUTION: Using a Windows 7 operating system DVD completely erases hard drive contents and
reformats the hard drive. All files you have created and any software installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows 7 operating system DVD:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows 7 operating system DVD into the optical drive
before the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

5. Click Next.

6. Select Repair your computer.

7. Follow the on-screen instructions.

After the repair is completed:

1. Eject the Windows 7 operating system DVD, and then insert the Driver Recovery disc.

2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.

Performing a system recovery 103

http:// www.hp.com/go/contactHP
http://welcome.hp.com/country/us/en/ wwcontact_us.html
http://welcome.hp.com/country/us/en/ wwcontact_us.html


8 Power cord set requirements

The wide-range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts AC, or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries
The following requirements are applicable to all countries and regions:

● The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

● All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

● The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

● The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions

Country/region Accredited agency Applicable note number

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

The Netherlands KEMA 1

Norway NEMKO 1

The People's Republic of China COC 5

South Korea EK 4

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 4

The United Kingdom BSI 1

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall plug
must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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9 Recycling

When a non-rechargeable or rechargeable battery has reached the end of its useful life, do not dispose
of the battery in general household waste. Follow the local laws and regulations in your area for
battery disposal.

HP encourages customers to recycle used electronic hardware, HP original print cartridges, and
rechargeable batteries. For more information about recycling programs, see the HP Web site at
http://www.hp.com/recycle.
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service cover
location 16
removal 47
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SIM, removal 46
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Smart Card reader, location 13
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spare part numbers 25, 29,
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removal 68
spare part number 24, 33, 68

specifications
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removal 75
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T
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removal 80
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TouchPad button 11
TouchPad cable, illustrated 28
TouchPad components 11
TouchPad light 10
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transporting guidelines 41
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USB port 13

V
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spare part number 26, 33, 88
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removal 88
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wireless antenna
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spare part number 26, 32,
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Wireless Antenna Kit, spare part

number 89
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wireless, product description 3
WLAN module

removal 51
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workstation guidelines 41
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removal 53
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